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List of abbreviations

AVSS – Ground analogue (GND)

A – Square wave signal A (P = positive; N = negative)

B – Square wave signal B (P = positive; N = negative)

COS – Cosine signal (P = positive; N = negative)

DNC – Do not connect

DVDD – Supply voltage digital (+ 5 V)

DVSS – Ground digital (GND)

EN – Error signal negative

EP – Error signal positive

MA – Master clock SSI (P = positive; N = negative)

REF  – Reference signal (P = positive; N = negative)

RS-422 – EIA-422 (line-bound differential serial data transmission)

SENSVDD – Supply voltage analogue (+ 5 V)

SIN – Sine signal (P = positive; N = negative)

SLI – SSI data input (P = positive; N = negative)

SLO – SSI data output (P = positive; N = negative)

SPI – Serial peripheral interface

SSI – Synchronous serial interface

TEACH – Teach signal of the AM-IP4k

TRG – Trigger signal of the AM-IP4k

V0 – Mean voltage

Vpp – Peak-to-peak voltage 

Z – Square wave signal Z (P = positive; N = negative)

ZER – Zero signal of the AM-IP4k
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1  Overview 
The programmable interpolation unit IPE4k is designed to increase the resolution of incremental position and
angular measuring systems with sinusoidal output signals offset by 90°. It can be used with various encoder
systems, which operate according to different measuring principles. The signal period is divided up to 4096
times. The interpolation unit can be used with both single-ended and differential input signals. The configura -
tion is carried out either via USB, via SSI interface, or via the internal EEPROM of the AM-IP4k. It is possible
to equip the interpolation unit with a SPI interface (3.3 V or 5 V system).
An AMAC-specific gain and offset control as well as the phase correction of the AM-IP4k inside ensure a high
accuracy of measurement in industrial environments.
The interpolation unit can be connected to a standard meter or to a control (delivery status) via RS-422 inter -
face. Alternatively, it is possible to change the configuration via USB and to connect the unit to a SSI master.
The operating voltage is 5 VDC.
The interpolation unit suits perfectly the use in control systems because of the features of the interpolation
circuit AM-IP4k, such as configurable low pass filter or a digital hysteresis.

Figure 1: Block diagram

Info:
Detailed descriptions of all features can be found in the data sheet of the AM-IP4k.
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2  Features
Table 1: Feature overview

Interfaces 

Analogue input - Sine- / Cosine- / Reference signal; differential or single-ended*
- Nominal amplitude configurable to 1 Vpp / 500 mVpp / 250 mVpp / 75 mVpp

- Maximum input frequency up to 220 kHz

ABZ - 90° square wave sequences (A/B/Z).
- Adjustable width of the index signal Z of ¼ or 1 period A/B
- Error signal
- Interrupt signal for µC
- Additional signals for sensor adjustment

SPI1) - 30 bit count value / 16 bit multi-turn value
- Data rate up to to 500,000 measured values/s
- 9 bit signal monitoring
- Compatible with standard SPI: 16 bit, MSB first, up to 25 MHz
- Signal filter for noise suppression to be enabled

SSI - Up to 30 bit count value / 16 bit multi-turn value 
- SSI 20 bit or 32 bit
- 2 bit signal monitoring
- Gray code / Binary code
- Adjustable timing
- SSI ring mode

Other inputs - Trigger signal for measured value storage
- Zero signal and teach signal for sensor’s zero point adjustment and storage

Current ouput - Controlling a laser diode for optical sensors
- Controlled by square of the input signal’s absolute value

Configuration options - Internal EEPROM 
- Serial SPI interface1)

Interpolation / Signal processing 

Interpolation rates - Interpolation basis rate: 4096, 4000, 3200, 2560
- Configurable divider: 1, 2, 4, 8, 16, 32, 64, 128 additionally for basic IR 4096 (256, 512, 1024)
- Interpolation rate adjustable at will via EEPROM table, default IR setting value 2560

Signal adjustment - AMAC-specific digital controller for offset, control range ±10% of the nominal amplitude
- AMAC-specific digital controller for amplitude, control range 60% … 120% of the nominal amplitude
- Digital potentiometer with 64 steps for phase correction; setting range ±5° or ±10°
- Input signal monitoring with configurable error indication

Signal correction - Wobble correction for periodic errors over 360° (rotary encoder)
- Signal form correction for periodic errors within one sine/cosine period (for linear encoder too)
- Can be activated or deactivated separately

Interference suppression - Adjustable low pass filter (Cut off frequencies10 kHz, 75 kHz, 250 kHz)
- Digital hysteresis to suppress output edge noise
- Adjustable minimum edge separation (band width limitation) at the output

Reference signal processing - Adjustable reference position 0 … 360°
- Determination of the optimum reference position via SPI or additional signals 
- Processing of distance coded reference marks
- Measured value trigger at the reference position

Other - 2-stage measured value trigger
- Programmable timer (3.2 μs … 420 ms) 
- Constant  delay between sampling and measurement  for  all  resolutions  (at  40 MHz)  without  signal
correction 2.35 µs, respectively 3.95 µs with signal correction 
- Multi-turn counter

Main features

Operating voltage 5 VDC 

I/O voltage, digital 3.3 VDC

Temperature range -40 … +125°C 

Interface clock frequency SPI 25 MHz (15 MHz via on-board USB-SPI-Converter), SSI 5 MHz

1) If the SPI option is selected

* with external adjustment (negative inputs SINN, COSN, REFN at mean voltage) respectively operating AM-IP4k at single-ended mode 
(CFG3_SE_VR_int=1) using VM_OUT as mean voltage for SINP, COSP and REFP (negative inputs SINN, COSN, REFN internally set directly at VM)
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3  Input signals
The IPE4k requires voltage signals as input signals, having a sinusoidal dependency on the measured value
(position or angle) and a  90° phase shift related to a period of the scale. A third input signal is used as
reference point signal to determine the zero point at the scale. It is possible to process all three input signals
as single-ended as well as differential signals.

Figure 2: Input signal (single-ended) Figure 3: Input signal (differential)

3.1  Measuring system connection

Figure 4: Measuring system connection
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3.2  Description of the input amplifier 
The gain can be set using the register CFG1 (see also the AM-IP4k’s data sheet).

Table 2: Description of the input amplifier 

CFG1/GAIN(1:0) 00 01 10 11

Input voltage for differential supply at each input  (mVpp) 1) 500 250 125 37.5

Input voltage for single-ended supply (mVpp) 2) 1000 500 250 75

Input voltage range for interpolation VDiff (mVpp) 600...1200 300...600 150...300 45...90

Mean voltage at input (V) 2.5 2.5 2.5 2.5

Mean voltage at SMON/CMON nominal (V) 1.1 1.1 1.1 1.1

Gain factor (2xVMON / VDIFF)3) 1.27 2.54 5.24 16.76

Bit CFG2 / LP recommended recommended recommended necessary 
1) At each of the inputs SINP, SINN, COSP, COSN
2) SE_AMP2 = 1, SE_HALB = 1
3) WIDE = 0, SE_AMP2 = 0, SE_HALB = 0

3.3  Signal adjustment and correction

3.3.1  Amplitude and Offset 
The input signals are subjected to an AMAC-specific gain and offset control. The amplitudes are controlled
within a range between 60 % and 120 % of the nominal amplitude. The control range of the offset of both
input signals is ±10 % of the nominal amplitude. The phase deviation of the input signals can be corrected
statically within a range of ± 5° and ± 10° using the internal digital potentiometer. 

Table 3: Signal correction

Parameter
in percent of the

nominal amplitude
(PEAK-PEAK)

in percent of the
ADC-Maximum
(PEAK-PEAK)

in mV of the
standard signal

(0.66 Vpp)

in V at Pin
SMON or CMON
(PEAK-PEAK)

Maximum value at the input (Vmaxpp) 150 100 990 1.90

Nominal value of the input signal (Vnompp) 100 66.7 660 1.27

Amplitude’s guaranteed control range 60 ... 120 40 ... 80 400 ... 800 0.76 … 1.52

Setting range of the amplitude controller 56 ... 168 1) 38 ... 112 1) 370 ... 1110 1) 0.71 … 2.13 1)

Vector monitoring 2) 30 20 200 0.38

Offset’s guaranteed control range (sensor) ±15 ±10 ±70 ±0.133

Setting range of the offset controller ±25 ±17 ±165 ±0.315
1) The amplitude’s setting range exceeds the ADC’s dynamic range.
2) A sum signal of sine and cosine is monitored, see chapter 7.6 bit VLOW at the data sheet of the AM-IP4k.

3.3.2  Correction of periodic errors
Two corrections can be applied to the sampled signal for periodic error compensation. The 360° correction
(wobble correction) of position errors during a complete sensor rotation is suitable only for rotary
encoders. In contrast, the SC correction3 (signal form correction) analyses a single sine period of the sensor
signal and therefore can be applied to linear encoders, too.

The corrections can be activated and deactivated separately, but work only with a valid EEPROM
configuration loaded. Besides general settings this configuration has to contain the correction coefficients
valid for a particular input signal.
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Table 4: Correction register 

Name SPI-Address [Bit] EEP-Address [Bit] Function

DISKSC 0x13 [2] 0x09 [10] '1' = SC correction off

DISK360 0x13 [1] 0x09 [9] '1' = 360° correction off

Koeffizienten_360 0x40...0x5F 0xA0...0xBF Table of coefficients for 360° correction

Koeffizienten_SC 0x60...0x7F 0xC0...0xDF Table of coefficients for SC correction

Zahnzahl 0x1B [4:0]...0x1A[7:0] 0x0D[12:0] Number of teeth for 360° correction

Korrekturwert SC 0x94...0x97 - Calculated correction value SC correction

Korrekturwert 360 0x98...0x9B - Calculated correction value 360° correction

LDR_OUT 0x9C...0x9F - Output value of laser diode control

Note: 
The current software release of the IP4k Monitor does not yet include the determination and calculation of the signal cor-
rection coefficients for periodic errors. These features will be part of a future software release.

3.4  Reference signal 
The reference signal is usually also called index respectively zero point signal, or Z-signal. A reference point
is detected as the voltage at the input pin REFP is higher than the voltage at the input pin REFN.

Figure 5: Reference signal 

Info:
If there is no need for a reference signal at the input, the reference point processing may be switched off using the in-
ternal configuration of the IPE4k.

Table 5: Internal reference signal 

Register values CFG3 / DISZ Meaning 

0 Reference signal at output active 

1 Reference signal at output inactive 

Info:
The shape of the Z-signal at the IPE4k’s output can be adapted to different applications by configuring the IC. If an incre-
ment is selected for the width of a Z-signal, the Z-impulse at the output will correspond exactly to a quarter period of the
signals A and B. The Z-impulse will last one full period if four increments are selected.

Table 6: Configuration of the reference point 

Register values CFG3 / Z4 Meaning 

0 1 increment = ¼ period

1 4 increments = 1 period 
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4  Output and input signals 
The IPE4k runs two different modes. The ABZ mode is the normal counter mode with ABZ signals at the
output.  Operating at  SSI mode (only counter mode), it  is  possible to read out measured values via the
interface. The IPE4k will be delivered running ABZ mode, but modes can be configured by USB. 

4.1  Output signals RS-422 – ABZ mode 
The  phase-shifted  square-wave  signals,  to  be  counted  by  single  or  quadruple  evaluation,  typical  for
incremental encoders, are the output signals at ABZ mode. A synchronous Z-signal will be generated if an
angle of 0° (see also figure  5) is passed through and the analogue differential input voltage between the
reference signal inputs REFP and REFN is positive. If the differential input voltage is permanently positive,
the reference impulse will be generated once per input signal period. 

Figure 6: Output signals ABZ 

Info:
The signals A, B and Z will be postponed by one increment if the digital hysteresis is activated.

4.2  Output and input signals RS-485 – SSI mode
At  SSI  mode measured  values  can  be  read  out  via  the  interface.  The  SSI  interface  is  inactive  with  a
connected USB.

4.2.1  SSI interface 

The SSI interface of the AM-IP4k will be activated if during the IC’s reset the input SEN is kept at the L-level.

For the AM-IP4k operating via the SSI interface, the EEPROM must contain a valid configuration because
the EEPROM contains some basic operating parameters. The bits SSITO and RING at the register CFGSSI
are initialised by the user using the system parameters at the EEPROM to operate the interface.
The register POSIT (see the data sheet of the AM-IP4k) is transmitted with a data length of 20 or 32 bits in

the data of the SSI protocol. The data contains the value of the interpolation counter (single-turn counter)
and of the multi-turn counter. Additionally, two bits are assigned to error information. Setting the bit RING at

the register CFGSSI enables the SSI master to force the repeated transfer of the same value by a continuous

clock (SSI ring mode).

Info:
Using the multi-turn counter the interpolation rate should be set to 256, 128, 64, or 32, as the higher-level
interface master usually operates only with binary resolutions.
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Figure 7: SSI

Figure 8: SSI (Ring mode)

Table 7: Register CFGSSI (SSI mode) 

Bit Meaning Factory setting User setting

SSITO SSI timeout 20µs at 40 MHz SSITO = (Timeout·fOSZ)-3

RING SSI ring mode Ring mode SSI master mode

SSI20 Data length 32 bits 0 for 32 bits / 1 for 20 bits

4.3  Error signal 
An error signal will be generated if the input signals are implausible. There will be an error signal too if the in -
put frequency is that high so the square-wave signals can no longer follow or that it exceeds the maximum
input frequency. In general, it is recommended to use the error signal for data processing. Further informa-
tion concerning the error signal are provided in chapter 7.6 of the AM-IP4k’s data sheet.

Info:
If the error signal was detected at the output, the current measurement result and all subsequent results must be dis-
carded. After the removal of the cause of error and the reset it is necessary to cross the reference point again to be able
to measure absolute values.

4.4  Trigger signal 
The trigger signal can be used to save the current count value to a trigger holding register of the AM-IP4k.
The respectively “oldest” value is provided from the trigger holding registers when there is a read-access to
the register MVAL. 

4.5  Teach signal
Using the teach signal a zero point position can be stored in the AM-IP4k’s EEPROM. The signal has to be
activated by the configuration bit TEAEN at register CFG2. For more details, see the data sheet of AM-IP4k,
chapter 7.10. 

4.6  Zero signal
The internal counter of the AM-IP4k and – in case of an error – the corresponding error bit can be reset by
the zero signal. After doing so it is necessary to cross the reference point again to be able to measure abso -
lute values.
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5  Interpolation rate 
Interpolation rates (IRATE) can be set between 4 and 4096. Interpolation rate in this context means the
number of increments into which a sine or cosine input signal period can be divided.

The interpolation rate is configured at CFG1/IR. There are four basic interpolation rates: 4096, 4000, 3200,
and 2560. The last has a factory setting value and can be reprogrammed by user. The succeeding interpola-
tion rate values correspond to the division by 2, 4, 8, 16, 32, 64, and 128 of basic interpolation rates. Invalid
values occur when result division is not an integer. 

Table 8: Interpolation rate

       IR(2:0)

IR(4:3)
000 001 010 011 100 101 110 111

10 4096 2048 1024 512 256 128 64 32

00 4000 2000 1000 500 2501) 1251) invalid invalid

01 3200 1600 800 400 200 100 501) 251)

11 2560 1280 640 320 160 80 40 20
1) These interpolation rates should only be used while running counter mode. In these cases, ABZ signals are invalid.

It  is  also  possible  to  select  further  interpolation  rate  values  with  an  extended  IR  divider.  The  basic
interpolation rates remain the same. Using configuration IRDiv2 in CFG2 the interpolation rates 16, 8, and 4
can be selected. See Table 15.

IR_sum(3:0) = IR(2:0) + IRDiv2(2:0)

Table 9: Interpolation rate with extended IR divider

IR_sum

IR(4:3)
0000 0001 0010 0011 0100 0101 0110 0111 1000 1001 1010

10 4096 2048 1024 512 256 128 64 32 16 8 4

00 4000 2000 1000 500 2501) 1251) invalid invalid invalid invalid invalid

01 3200 1600 800 400 200 100 501) 251) invalid invalid invalid

11 2560 1280 640 320 160 80 40 20 invalid invalid invalid
1) These interpolation rates should only be used while running counter mode. In these cases, ABZ signals are invalid.
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5.1  Edge separation for ABZ signals
The minimum edge separation tpp of the output signals A, B and Z can be set in binary steps between 1/fosz

and 128/fosz. Using this function, the band width of the IPE4k can be restricted to slower RS-422 counters
(see for details the data sheet of the AM-IP4k, chapters 7.4.2, 7.5).

Table 10: Minimum edge separation 

Minimum edge separation tpp Register values CFG1 – TPP(2:0)

1/fOSZ 000 (0)

2/fOSZ 001 (1)

4/fOSZ 010 (2)

8/fOSZ 011 (3)

16/fOSZ 100 (4)

32/fOSZ 101 (5)

64/fOSZ 110 (6)

128/fOSZ 111 (7)

5.2  Digital hysteresis for ABZ signals
To suppress the edge noise of the output signals at low input frequencies as well as during downtime, a
digital  hysteresis  for  A,  B and Z can be activated at  register  CFG1.  Thus,  switching of  outputs  will  be
prevented if static input signals occur. All output signals will be delayed by the set hysteresis value.

Table 11: Configuration of the digital hysteresis 

Register values CFG1 DH(2:0) Meaning 

000 Digital hysteresis deactivated

001 to 111 Digital hysteresis activated and setting of the hysteresis value
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6  Characteristic values
Table 12: Characteristic values 

Operating conditions Min. Nom. Max. Unit 

Operating voltage 4.75 5.0 5.5 V 

Current consumption 110 230 mA 

Internal supply voltage 3.3 V 

Mean voltage at VM_OUT 2.5 V 

Output current at VM_OUT 30 mA 

Operating temperature - 40 85 °C 

Input section Min. Nom. Max. Unit 

Input frequency 220 kHz 

Phase shift between SIN and COS 90 ° 

Amplitude SINN  SINP / COSN  COSP 0.075 1.0 1.2 Vpp

Phase correction 4.5 / 9 5 / 10 9 / 11 ° 

Oscillator frequency fosz 40 MHz 

Interpolation Min. Nom. Max. Unit 

Interpolation rate 4 … 4096 

Minimum interval time tpp A / B signal 1 / fOSZ 128 / fOSZ ns 

Interpolation accuracy ± 0.7 

Delay time (A / B / Z) 155 / fOSZ 187 / fOSZ ns 

Other characteristics Housing made of extruded profile

Degree of protection IP20 

Connectors SUB-D, 15-pin 

Dimensions 55 mm x 80 mm x 20 mm 
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7  Configuration of the connectors 
7.1  Pin assignment of connector X1, ABZ/ SPI
Table 13: Connector SUB-D 15-pin → ABZ 

Pin Name Signal Meaning 

1 AP Output Square-wave signal A positive 

2 VSS Input GND

3 BP Output Square-wave signal B positive 

4 VDD Input Supply voltage 5 V

5 EP Output Error signal E positive 

6 nTEACH Input with pull-up Teach signal; falling edge active 

7 ZN Output Square-wave signal Z negative

8 nTRIG Input with pull-up Trigger signal; falling edge active

9 AN Output Square-wave signal A negative

10 VSS Input GND

11 BN Output Square-wave signal B negative

12 VDD Input Supply voltage 5 V

13 nZERO Input with pull-up Zero signal; falling edge active

14 ZP Output Square-wave signal Z positive

15 EN Output Error signal E negative

Table 14: Connector SUB-D 15-pin → SPI

Pin Name Signal Meaning 

1 MISO Output SPI master in salve out

2 VSS Input GND

3 SEN Output SPI SEN signal

4 VDD Input Supply voltage 5 V

5 EP Output Error signal E positive 

6 nTEACH Input with pull-up Teach signal; falling edge active 

7 ZN Output Square-wave signal Z negative

8 nTRIG Input with pull-up Trigger signal; falling edge active

9 MOSI Output SPI master out slave in

10 VSS Input GND

11 SCLK Output SPI clock

12 VDD Input Supply voltage 5 V

13 nZERO Input with pull-up Zero signal; falling edge active

14 ZP Output Square-wave signal Z positive

15 EN Output Error signal E negative
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7.2  Pin assignment of connector X1, SSI mode
Table 15: Connector SUB-D 15-pin → SSI 

Pin Name Signal Meaning 

1 SLOP Output Signal SLO positive 

2 VSS Input GND

3 SLIP Input Signal SLI positive 

4 VDD Input Supply voltage 5V

5 SENN Input Signal SEN negative 1) 

6 nTEACH Input with pull-up Teach signal; falling edge active 

7 MAN Input Signal MA negative

8 nTRIG Input with pull-up Trigger signal; falling edge active

9 SLON Output Signal SLO negative

10 VSS Input GND

11 SLIN Input Signal SLI negative

12 VDD Input Supply voltage 5V

13 nZERO Input with pull-up Zero signal; falling edge active 

14 MAP Input Signal MA positive

15 SENP Input Signal SEN positive 1) 

1) Signals do not have to be connected. Interface configuration using the SEN signal is done internally. 
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7.3  Pin assignment of connector X2
Table 16: Connector X2 test signals sine / cosine of the analogue input of the AM-IP4k 

Pin Name Signal Meaning 

1 SMON Output Test signal of the sine channel of the analogue input of the AM-IP4k 

2 CMON Output Test signal of the cosine channel of the analogue input of the AM-IP4k

3 GND Input Analogue ground for measurements 

7.4  USB interface X4
Table 17: USB interface X4 

Pin Name Meaning 

1 + USB + 5 V 

2 USBD - Data - 

3 USBD + Data + 

4 ID – 

5 - USB GND 

7.5  Pin assignment of female connector X6 
Table 18: Female connector SUB-D 15-pin 

Pin Name Signal Meaning 

1 SINP Input Sine positive

2 AVSS Output GND

3 COSP Input Cosine positive

4 SENSVDD Output
Supply voltage 5 V

(equipment variant with 3,3V)

5 – – – 

6 – – – 

7 REFN Input Reference signal negative

8 – – – 

9 SINN Input Sine negative

10 AVSS Output GND 

11 COSN Input Cosine negative

12 SENSVDD Output 
Supply voltage 5 V

(equipment variant with 3,3V)

13 VM_OUT – SENSVDD/2

14 REFP Input Reference signal positive

15 – – –

7.6  LED 
Table 19: LED 

LED Signal Meaning

nERR
LD4
LD6

Red (LD6 off) An error occurred

Green (LD4 off) Normal operation 

Power LED
LD3

Off IPE4k not active

Green IPE4k active
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8  Configuration of AM-IP4k
8.1  Configuration of AM-IP4k using “IP4kApp.exe”
After a reset of the IC AM-IP4k all  registers will  be initialised with their default values. If  the IPE4k was
connected to a PC via USB according to the instructions, the AM-IP4k could be easily set using the PC
software  “IP4k-Monitor”.  Furthermore,  the  active  interface  at  X1 can  be selected  by  this  program.  The
program is available for download on our website www.amac-chemnitz.de.

Note: 
To avoid difficulties in communicating with the PC, the hardware address of the IPE4k is set at 0x00 and must not be
modified in the software.

9  Software – IP4k-Monitor
9.1  Overview
The IP4k-Monitor-Software allows to visualise and control the parameters and characteristics of the AM-IP4k,
which  is  built  in  the  IPE4k.  The  software  is  designed  for  Windows  operating  systems  and  has  to  be
connected by USB (USB to SPI on the board).

9.2  System requirements
To ensure the proper running of the program the PC or notebook should meet the following minimum system
requirements:

Hardware:
• Processor: 2 GHz or faster (a multi-core processor is recommended)
• at least 512 MB of RAM
• at least 1 GB available hard-disc space (for measured values)
• Graphics card with 24-bit colour (32-bit recommended)
• 1024 x 768 display or higher
• available USB interface

Operating system1):
• Microsoft Windows® Server 2003
• Microsoft Windows® Vista
• Microsoft Windows® 7 
• Microsoft Windows® 8.1
• Microsoft Windows® 10 and above

1) Microsoft and Windows® are registered trademarks of Microsoft Corporation in the US and other countries.

9.3  Installation
The software and USB drivers are installed using the executable file 50410-SW-x-x-IP4k-monitor Setup.exe.
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9.4  Program structure
The configuration program’s graphical interface is organised in a dialogue bar, a status bar and two sectors
displaying the measured values. Below the tool bar, there is the dialogue bar to start taking measurements
and to select the time interval for queries or to trigger reset commands for e.g. the counter. The measured
values and the status information of the AM-IP4k are shown in the two measurement parts of the window,
provided that a measurement was started via the dialogue bar. The measured values are updated within the
specified time interval.

After  starting  the  application,  shown  in  figure  9,  the  software  checks  the  hardware  availability.  If  any
hardware is detected, its identifier will appear in the status bar. If the IC is properly connected and activated,
the circuit’s name will appear in the status line (e.g. “IC: AM-IP4k”). In case no circuit is detected, “unknown”
will appear.

9.5  Menu bar
Table 20: Menu bar – Symbols

Symbol Name Meaning

New document Creates a blank configuration file.

Open document Opens an existing file and reads the configuration settings.

Save document Saves the configuration settings to a file.

Oscilloscope view Opens the oscilloscope view, see chapter 9.9.

Export data Exports the measured data to a file.

Configuration Opens the configuration window, see chapter 9.8.

Information Shows information about the program and about the connected hardware.
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9.6  Support
During  the  development  of  the  configuration  program  special  attention  was  paid  to  a  clear  and  self-
explanatory graphic interface.  Many elements of the interface show further information by mousing over
(tooltip or status text). The setting made in this program can be saved to a setup-file with the extension
“.ip4k” and retrieved again.

9.7  Measurement
Once an AM-IP4k is connected to the PC and detected by the software, a live measurement can be taken by
pressing the start button. The displays in the two measurement windows are updated within the specified
time interval with the selected time value of the interval being an approximate value. The real value of the in -
terval depends on configuration of the software and the interface plus of the performance and capacity of the
PC.

9.7.1  IP measurement 1

Figure 10: Interpolation measurement 1

During a measurement, the current count value is shown in the window IP measurement 1. It is possible to
choose between measured value (register MVAL of the AM-IP4k), count value (register CNT) and position
(register POSIT; see the description of the registers at the AM-IP4k’s data sheet).  By choosing position,
single  and  multi-turn  information  can  be  displayed  depending  on  the  circuit  configuration  (registers
CFGSSI/MTBIT, CFGSSI/STBIT).

The signalling of the error LEDs depends on the circuit configuration. The error events can be activated, deactiv -
ated or stored permanently at the configuration register CFG1. The behaviour of the LEDs will be adapted accord-
ingly. The LEDs for error, trigger and reference point status correspond to the information at the status register
STAT of the AM-IP4k. The meaning of the error LEDs is given in table 21; the status LEDs are described in table
22.
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Table 21: Error LEDs

LED Meaning

EVLOW Green: No vector error.
Red: The signal vector generated from the sine and cosine signal is too small, caused mostly by a partially

or totally disconnected sensor. Another cause of error may be input signals with a very large offset 
and a low amplitude at the same time.

ECADC Green: No ADC error at the cosine signal.
Red: The AD converter for the cosine signal is overdriven, caused by a signal amplitude being too high. 

Another cause of error may be input signals with a very large offset and a high amplitude at the same
time.

ESADC Green: No ADC error at the sine signal.
Red: The AD converter for the sine signal is over-driven, caused by a signal amplitude being too high. An-

other cause of error may be input signals with a very large offset and a high amplitude at the same 
time.

EFAST Green: No speed error.
Red: The input frequency is too high to generate A/B signals or to detect the direction. The monitored fre-

quency differs in the use of the internal counter and of the square-wave outputs A/B/Z.

EABZ Green: No error at A, B, Z.
Red: The signals A, B and Z are invalid because of the input frequency being too high. The monitored fre-

quency depends on the set minimum edge separation tpp. This error will occur too if the interpolation 
rate or the minimum edge separation tpp are changed. The detection of this error will be deactivated 
automatically using the internal counter.

ECGAIN Green: No amplitude error at cosine signal.
Red: The gain controller for the cosine signal has reached its limit, caused either by a signal amplitude be-

ing too low or by a partially or totally disconnected sensor.

ESGAIN Green: No amplitude error at sine signal.
Rot: The gain controller for the sine signal has reached its limit, caused either by a signal amplitude being 

too low or by a partially or totally disconnected sensor.

ECOFF Green: No offset error at cosine signal.
Red: The offset controller for the cosine signal has reached its limit, caused by a signal offset being too 

large, by an invalid value for the initialisation of the offset controller or by a partially or totally discon-
nected sensor.

ESOFF Green: No offset error at sine signal.
Red: The offset controller for the sine signal has reached its limit, caused by a signal offset being too large,

by an invalid value for the initialisation of the offset controller or by a partially or totally disconnected 
sensor.

EKOVL Green: No error at correction value calculation.
Red: The calculated correction value is invalid, caused by a wrong configuration of the correction coeffi-

cients. The sensor should be calibrated again.

Table 22: Status LEDs

LED Meaning

TRGPIN
Trigger status (Pin)
active: The next measured value read from register MVAL was triggered by Pin TRG.
inactive: Register MVAL contains the current position value (Register POSIT).

TRGTIM
Trigger status (Timer)
active: The next measured value read from register MVAL was triggered by timer.
inactive: Register MVAL contains the current position value (Register POSIT).

TRGZ
Trigger status (Reference point)
active: The next measured value read from register MVAL was triggered by reference signal.
inactive: Register MVAL contains the current position value (Register POSIT).

TRGOVL
Trigger overflow
active: Overflow of the trigger holding register. A trigger event was lost.
inactive: No overflow of the trigger holding register. At the most two trigger events will be stored.

ZSTAT

Reference point status
active: The reference mark of the scale was passed; AM-IP4k and scale work synchronously.
inactive: Reference mark of the scale was not yet passed or the relation between count value and reference 
mark was lost due to an error.
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9.7.2  IP measurement 2
The quality of the sensor signals is illustrated with LED bars of the controller parameter in the window IP
measurement 2. Additionally, the input voltage at the AD converters is monitored; thus, a possible overload of
the ADC will be visualised by the software. The meaning of the displayed elements is shown in the tables 23
and 24.

Figure 11: Interpolation measurement 2

Table 23: Sensor monitoring

Name Type Meaning

Gain cosine
Gain sine

LED bar Controller correction value for the signal amplitude.

Measured value Controller value for the input signal amplification.

Offset cosine
Offset sine 

LED bar Offset correction value of the controller.

Measured value Controller value for the offset correction.

Vector LED bar Vector magnitude of the input signals.

ADC cosine
ADC sine

LED bar Range of values of the AD converter.

Measured value Current input voltage at the AD converter.

Table 24: Range of values of the sensor monitoring

Display Meaning

LED bar
green

yellow on the left
yellow on the right 

red on the left 
red on the right 

Value ...
... is within the permissible range
... is too small, sensor signal should be aligned
... is too big, sensor signal should be aligned
... is too small, measured value is incorrect
... is too big, measured value is incorrect 

9.8  Configuration
The software reads out the current configuration after detecting the circuit. The user’s possibilities are to con-
firm that or to create a new configuration (File → New; symbolised as a blank sheet). In addition, a previously
saved configuration with the extension *.ip4k can be loaded (File → Open; symbolised as folder).

Figure 12: Configuration readout
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The configuration window can be opened via the menu (Tools → Configuration) or via the tool bar. There are
several tabs for the basic and the advanced configuration of the circuit as well as for software settings.
As the configuration is stored to the circuit’s internal EEPROM and validated automatically, it can be loaded
from the EEPROM at the power-on or the reset of the IC and can be used. The validity of the configuration is
stored to EEPROM address 0x00. If the circuit is supposed to be used with the default settings, the content
of the EEPROM must be validated first by using a button in the configuration window (Sensor – Expert). Ad -
ditionally, the validity of the EEPROM is displayed. With an external configuration of the circuit (CFGPIN) the

default settings are used for all characteristics not configured by pins and the programmed EEPROM content
is not applied to the configuration. 

9.8.1  Sensor - Parameter / Expert
At the configuration menu’s first tab “Sensor – Parameter” basic settings as interpolation rate and input amp-
litude can be adjusted, which makes it possible to adapt the AM-IP4k’s basic settings without much effort.
To save the selected settings to the EEPROM of the AM-IP4k the button “Program” has to be pressed. The
button “Verify” is used for comparing the data of the software with those of the EEPROM and returns a result
of the comparison. If there are differences, the EEPROM values can be checked using the “Read” button
and shown in the software’s display.

Figure 13: Sensor parameter

For further adjustments of the AM-IP4k the tab “Sensor – Expert” is intended to be used. This tab is based on
the definitions of the configuration registers CFG1-4, CFGSSI, PRE_ST, PRE_MT, CFGIUW, CFGLDR, and
CFGLDR2, which can be programmed individually using this tab. A detailed description and explanation can
be found in the data sheet. The tasks “Program”, “Verify”, and “Read” can be executed as described above.
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Figure 14: Sensor expert – CFG1

Figure 15: Sensor expert – CFG2

Figure 16: Sensor expert – CFG3
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Figure 17: Sensor expert – CFG4

Figure 18: Sensor expert – SSI

Figure 19: Sensor expert – PRE_ST
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Figure 20: Sensor expert – PRE_MT

Note: 
The use of the AM-IP4k’s laser diode control is not possible in the current hardware release of the AM-IPE4k.

  

Figure 21: Sensor expert – IUW

Figure 22: Sensor expert – LDR
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Figure 23: Sensor expert – LDR2

9.8.2  Hardware – Communication
The communication via interfaces is set at this tab, including setting the clock divisor for communication via
SPI interface. The waiting time after a read-access can be determined for the SPI interface (for further in -
formation see the data sheet of the AM-IP4k). Output signals (SSI or SPI) to connector X1 can be selected at
the “Config. Output” sector.

Figure 24: Hardware – Communication
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9.8.3  Software – Display
At the tab “Software – Display” the unit of measurement and the scale for displaying measured values with
the software can be changed (IP measurement 1, Display: Measured value). Furthermore, warnings or other
kind of notes, which were blanked by the user, could be enabled again.

Figure 25: Software – Display

9.8.4  Software – Streaming
To record continuously the parameters of AM-IP4k, such as corrected and uncorrected ADC values, PHI, BQ,
the tab “Software – Streaming” can be used. The data as measured or raw data can be transferred by the
export function as CSV or MatLab data (Tools → Export; symbolized as a blank page with an arrow). Thus,
the subsequent analysis and further processing of data and generating a documentation is made possible.

Figure :26 Software Streaming
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9.9  Oscilloscope
The software also provides a graphical display of variables, e.g. ADC values or parameters of the AM-IP4k. In gen-
eral, it can be chosen between the time-based oscillogram and the one showing a XY representation.

Figure 27: Oscilloscope – Time-based oscillogram

Figure 28: Oscilloscope – XY representation
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10  Ordering information 
Table 25: Ordering information IPE4k 

Product type Description Article number 

IPE4k Interpolation unit with AM-IP4k (Standard configuration ABZ) PR-50410-00

10.1  Configuration as delivered
Table 26: Hardware configuration as delivered

Interface Description

Sensor input Differential input signals with 1Vpp, terminating impedance unpopulated

Output signals ABZ

Table 27: Software configuration as delivered

Parameter Configuration

Interpolation rate 4096

Reference point detection Active

Reference point width 1 increment

Output signals ABZ

Digital hysteresis Active

Low pass at input Inactive

Error signals Active, errors will be stored (Bit HLD at register CFG1 of AM-IP4k set)
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11  Hardware overview
11.1  Connections and test points 

Figure 29: Connections and test points

11.2  Dimensions 

Figure 30: Dimensions
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12  Notes
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